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Introduction
InstallAnywhere is the leading multiplatform installation and container development solution for application 
producers who need to deliver a professional and consistent installation experience for physical, virtual, and 
cloud environments as well as container deployments.

For the latest information about this release of InstallAnywhere, including updates to these release notes, see 
the online version of the InstallAnywhere 2018 release notes.

Changes in SP1
InstallAnywhere 2018 SP1 includes the following features:

• Configure Installer Updates

• Enable Downloadable Update Support

• Configure Prompt Message
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Configure Installer Updates
In InstallAnywhere 2018 SP1, you can now enable and configure a software downloadable update. The end user 
can either download a newer version or skip and proceed with the current installation process. A new Installer 
Updates option has been added to the Upgrades view where you can specify these downloadable update 
settings.

Enable Downloadable Update Support
You can now enable updates for the end users to see the downloadable update support. The installation has 
the ability to check for downloadable updates.

To enable updates, select the Enable Updates option on the Installer Updates option of the Upgrades view.

Specify Download URL
You can now enter the download URL in the Download URL field on the Enable Updates option on the Installer 
Updates option of the Upgrades view.

The Download URL is a web hosted location where iaupdate.xml and downloadable updates are hosted.

Enable Force Install
You can now use this option for the end users to forcibly download and install the updates (if available).

Configure Prompt Message
You can now customize the message and provide a title for the message that is displayed during the installation 
to prompt the end users.

Specify Prompt Message Title
You can now specify the title of the Upgrade Prompt message for the end users. 

Specify Prompt Message
You can enter the customized message in the Message field on the Upgrade Prompt  on the Installer Updates 
option of the Upgrades view. You can either provide a new message or use default localized string.

New Features
Refer to the following sections for new features in InstallAnywhere 2018:

• Perform Open Source Risk Assessment and Vulnerability Scan with FlexNet Code Aware

• All InstallAnywhere Features Now in a Single Edition
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• Redesigned InstallAnywhere Advanced Designer User Interface

• Enhanced Upgrade Installers Now Accommodate Maintenance Mode and Instance Management
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Perform Open Source Risk Assessment and 
Vulnerability Scan with FlexNet Code Aware

There is an increasing need to understand the licensing obligations of all open source software components 
being bundled with a software application. At the same time, users are getting increasingly worried about the 
vulnerabilities that these open source components bring in. With InstallAnywhere’s new FlexNet Code Aware 
scanning feature, users will get the insight into the licensing obligations and vulnerabilities associated with all 
open source components.

InstallAnywhere now includes full integration with FlexNet Code Aware, an automated open source risk 
assessment and package discovery solution that enables you to quickly scan your products for security and 
intellectual property (IP) compliance risk. 

• Supported File Types

• Running FlexNet Code Aware from Within InstallAnywhere

• Running FlexNet Code Aware as a Standalone Product

• Reading the FlexNet Code Aware Report

• More Information

Note • FlexNet Code Aware is automatically activated when you activate InstallAnywhere. However, the FlexNet 
Code Aware license expires one year from the date that it is first launched. 

Important • FlexNet Code Aware is not supported on 32-bit machines. A 64-bit operating system is required. 

Supported File Types

FlexNet Code Aware supports analysis of the following files: 

• Java Packages

• Node Packages

• Nuget Packages

• RPM Packages

• Ruby Packages

• EXE & DLL Files

Security vulnerabilities are looked up against the National Vulnerability Database (NVD). 
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Running FlexNet Code Aware from Within InstallAnywhere

To run FlexNet Code Aware from within InstallAnywhere, click Run FlexNet Code Aware Analysis on the 
InstallAnywhere Tools menu.

When FlexNet Code Aware completes the scan of your project, the Results Summary view opens, displaying the 
number of files scanned, and the number of open-source packages and vulnerabilities found. 

Figure 1: FlexNet Code Aware Results Summary

When you click the View Report button, a full report is displayed.
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Running FlexNet Code Aware as a Standalone Product

Rather than scanning the files in the open InstallAnywhere project, you can also launch FlexNet Code Aware as 
a standalone product and select a directory of files to scan. 

Figure 2: FlexNet Code Aware Welcome Panel

Just click Browse, select the directory that you want to scan, and then analysis will begin.
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Reading the FlexNet Code Aware Report

When you click View Report on the Results Summary screen, the full FlexNet Code Aware report opens, 
consisting of an Initial Summary view and a Package Inventory view.

Initial Summary View

The Initial Summary view presents the user with a scan summary, and assessments of operational risk, 
security vulnerability exposure, and license exposure. 

Figure 3: FlexNet Code Aware Initial Summary View

The FlexNet Code Aware Initial Summary View displays the following information:

• Scan Summary—This section provides details regarding the codebase that was scanned, including a 
breakdown of file types, percent of files analyzed, and number of findings. 

• Operational Risk—This section provides a composite risk rating based on the combination of packages 
with Intellectual Property (IP) issues and packages with Security Vulnerabilities. 

• Security Vulnerability Exposure and License Exposure—These sections provide a breakdown of the 
types and categories of identified issues. 
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Package Inventory View

The Package Inventory view, available by clicking View full package inventory in the Scan Summary section, 
provides a complete list of discovered open source and third-party packages with associated licenses, security 
vulnerabilities, dependencies, and detected copyright statements. 

Figure 4: FlexNet Code Aware Package Inventory View

The Package Inventory view provides filters that you can use to execute targeted queries to refine the list to 
various package types of interest.

To view additional package details, click a vulnerability count listed in the Vulnerabilities column of the 
package you want to review:

Figure 5: Vulnerabilities Column
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The Vulnerabilities Detail page opens (covering a portion of the Package Inventory view), and displays 
detailed information on the selected package.

Figure 6: Vulnerabilities Detail

More Information

For detailed information on using FlexNet Code Aware, see Using FlexNet Code Aware to Perform Open Source 
Risk Assessment in the InstallAnywhere Help Library.
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All InstallAnywhere Features Now in a Single Edition
Previous versions of InstallAnywhere were available in two different editions, Professional and Premier, with 
additional features included in add-on Virtualization and Cloud packs. Starting with InstallAnywhere 2018, all 
features are included in a single edition. 

After upgrading to InstallAnywhere 2018, you will have access to all features, including these features that were 
previously only available in Premier Edition and with the add-on packs:

• Extensive run-time language support—InstallAnywhere includes default run-time strings in 32 
supported languages, and gives you the ability to include custom localized splash screens in your 
installations. 

• Built-in support for creating upgrades—You can create upgrades that uninstall earlier versions of the 
product if present before installing the new version.

• Instance management support—You can create installers that let end users install multiple instances of a 
product on the same machine.

• Predefined and custom source path variables—You can use predefined source path variables in your 
installer, such as $IA_HOME$, $IA_PROJECT_DIR$, and $USER_HOME$. You can also use custom source 
path variables.

• Build time variables—You can configure your project to use build-time variables, variables that have their 
values set at build time.

• Flexible build configuration management—You can define tags to bundle related sets of actions, panels, 
features, and components, and assign the tags to the appropriate items in your project. Then you can 
associate the tags with specific build configurations to include or exclude items from builds.

• Flexible build target management—You can create different build targets for each platform that your 
product supports. 

• Ability to add custom GUI panels—You can design your own custom panels that guide end users through 
the selection or completion of various UI elements such as text boxes, check boxes, and lists.

• Merge module support—You can include merge modules in your installer project. 

• Project automation APIs—InstallAnywhere includes project automation APIs that let you design, modify, 
build, and test an installation from an InstallAnywhere project via Java code. 

• Docker support—You can use InstallAnywhere to configure and build Docker images, and deploy Web 
applications to the cloud as Docker images that are run as Docker containers.

• Virtual appliance support—You can build enterprise-ready and cloud-ready multi-tier virtual appliances 
for VMWare ESX based on your existing InstallAnywhere projects.

• Ability to share components with other products—You can optionally identify a component in your 
project as shared. At run time, if this type of component is not already present on a target system, the 
installer adds it. If it is already present, the installer registers it as shared. 

All existing customers will be upgraded to the full-featured, single edition. 
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Redesigned InstallAnywhere Advanced Designer User 
Interface

The user interface of InstallAnywhere 2018’s Advanced Designer has been redesigned and updated to provide a 
cleaner, more modern look, with a new black / gray / blue color scheme. 

A user-friendly tabbed interface improves the ease of switching between views. Buttons on the Sequence tab 
have been repositioned to a more logical location above the Action lists. 

Figure 7: Redesigned Advanced Designer User Interface of InstallAnywhere
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The Create/Open Project dialog box that opens when you launch InstallAnywhere has also been redesigned to 
be more user friendly.

Figure 8: Redesigned Create/Open Project Dialog Box

When you click Create new project on the Create/Open Project dialog box, the redesigned Create New 
Project dialog box opens, prompting you to select the desired template to use, enter a name for the project, 
and select a location for the project. 

Figure 9: Redesigned Create a New Project Dialog Box
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Enhanced Upgrade Installers Now Accommodate 
Maintenance Mode and Instance Management

In InstallAnywhere 2018, the behavior of upgrade installers has been enhanced to accommodate maintenance 
mode and instance management. 

Previously, upgrade installers did not support maintenance mode or instance management. Upgrade installers 
could only upgrade an earlier version of an application (by uninstalling the previous version and installing the 
new version), or, if an earlier version does not exist, just install the new version. 

In InstallAnywhere 2018, you can use an upgrade installer to add or remove features of a previously installed 
version as well as repair broken installations. You can also use an upgrade installer to specify whether multiple 
instances of a product can be installed on the same machine. At runtime, the user can choose which instance of 
the product to upgrade or perform maintenance on.

Note • This feature is not supported when performing a silent upgrade. 

Note • This change was tracked in issue IOJ-1754674. 

Enhancements

Enhancements in InstallAnywhere 2018 SP1
This section lists enhancements that were included in InstallAnywhere 2018 SP1: 

• Ability to Provide a Simple Way to get a Feature's Long Name from its Short Name

• Ability to Hold the Path for Global InstallAnywhere Registry Location

• Allow Alignment of Input Fields for Get User Input Panel

• Ability to Support tar.gz and tar.z

• Ability to Read REG_MULTI_SZ Values from Get Windows Registry Entry Action

• Option to Set Size field via InstallAnywhere Project for Add or Remove Programs Applet on Windows

• Expanded Search Functionality for String Values

• Support for Java 11

• Ability to Set Installer Title Image on a Linux and MAC Machine for Windows Build Target

Ability to Provide a Simple Way to get a Feature's Long Name from its Short Name

A new read only variable $CHOSEN_INSTALL_FEATURE_LIST_LONG$ is added under the InstallAnywhere 
Variables list which contains the long names of the installed Features. This variable can be used to get the long 
name of the feature from the feature short name.
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Ability to Hold the Path for Global InstallAnywhere Registry Location
A new read only variable $IA_GLOBAL_REG_LOCATION$ is added under InstallAnywhere Variables list which 
holds the path for global InstallAnywhere registry location. This variable can be used to determine where the 
global registry is present on the target machine.

Allow Alignment of Input Fields for Get User Input Panel
The Selection box for the ‘Control Alignment’ has been added in Get User Input Panel Advanced-> 
Configure Selection of Text Field. By default, the Alignment selection will be ‘Left’ and the alignment 
changes applies to Text Fields. 

There are two possible values for the text alignment controls that is ‘Left and ‘Right’.

Ability to Support tar.gz and tar.z
The Expand Tar action now also supports expanding of tar.gz and tar.z files.You can use the Expand Archive 
(TAR) action to expand a TAR, .gz, .Z archive file on the target system.

Ability to Read REG_MULTI_SZ Values from Get Windows Registry 
Entry Action

There is an ability to read multi string REG_MULTI_SZ values from the Windows Registry and store the value in 
an InstallAnywhere Variable(s).

Option to Set Size field via InstallAnywhere Project for Add or Remove 
Programs Applet on Windows

This new field 'Estimated size(in MB)' is added under Projects-> Platforms->Windows section for all 
project types. By default 'Estimated size(in MB)' field value will be blank. You can enter an estimated size of 
any value > 0 (Zero) and <= 4194303(4TB).

Note • Cannot enter floating/decimal value for an estimated size.

Expanded Search Functionality for String Values
Now, InstallAnywhere supports expand search functionality for String Value. If the partial search is unchecked, 
the string search will search for the whole text. If the partial search is unchecked, then the parts of strings & 
variables will also be searched. 

The “Variable Search” which is a new checkbox has been added in InstallAnywhere.

• If the Variable Search check box is checked, it will enclose with a dollar sign symbol ($) before and after the 
variable to search for a variable.
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• If the Variable Search check box is unchecked, it will not be enclosed with a dollar sign symbol ($) before 
and after the text to search for a string and variable.

Now, you can also replace strings. InstallAnywhere replaces all instances of the string with the replacement 
string.

Search for a string and select ‘Replace All’. Enter the string which you want to replace with.

Support for Java 11
InstallAnywhere 2018 SP1 now supports the latest version of Java, Version 11. Open JDK 11 VM packs that are 
bundled for Windows, Linux and MAC target platforms.

Using InstallAnywhere 2018 SP1, you can create installers that support Java 11, including:

• Creating Java 11 VM packs

• Creating installers which uses bundled Java 11 VM pack

• Creating installers that can detect a Java 11 on the host and run automatically

Ability to Set Installer Title Image on a Linux and MAC Machine for 
Windows Build Target

The Installer Title image setting is now enabled for Linux and MAC platform so that it can be used to build 
windows target from both Linux and Mac.

Enhancements in InstallAnywhere 2018
This section lists enhancements that were included in InstallAnywhere 2018: 

• Support for Java 9

• Ability to Customize the Windows File Properties of an Installer Executable File

• Ability to Customize the Get Info Property Value for Copyright Field for an OS X / macOS Build Target

• Ability to Add Checkbox to Install Complete Panel to Launch Target Application or README File

• Option to Disable Logging Upon User Cancellation During Pre-Install Sequence

• Execute Script/Batch File Action Run in Console Mode Now Writes Action Type and Identifier to Console

• In Console Mode, User Can Now Move Forward Without Scrolling Through the Entire License Agreement

• Ability to Set Compiler Flags, Such as SafeSEH, for Executables Installed on Windows

• ANT Version Associated with Execute ANT Script Action Updated to ANT 1.9.9

• New Compare Versions Rule

• Expand/Collapse Buttons on Sequence Page Views

• Get Password Action Console Panel Now Available in Pre-Uninstall and Post-Uninstall Phases

• New User-Defined Range of Installer Exit Codes
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• New Variable to Store Response File Location

• New Option to Specify Whether to Save Installer Project Before Build

Support for Java 9
InstallAnywhere 2018 now supports the latest version of Java, Version 9. Using InstallAnywhere 2018, you can 
create installers that support Java 9, including:

• Creating Java 9 VM packs

• Creating installers that bundle a Java 9 VM pack

• Creating installers that can detect a Java 9 VM on the host and run automatically

Ability to Customize the Windows File Properties of an Installer 
Executable File

In previous releases, when you viewed the Details tab of the Windows Properties dialog box for an 
InstallAnywhere installer .exe file, information specific to the version of InstallAnywhere used to create the 
installer was displayed instead of information specific to the product being installed:

Figure 10: Details Tab of Windows Properties Dialog Box

The following hard-coded values were displayed for all Windows .exe installers created using InstallAnywhere:

• File description—Displayed InstallAnywhere Self-Extractor.

• File version—Displayed the version of InstallAnywhere that was used to create the installer.
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• Product version—Displayed the version of InstallAnywhere that was used to create the installer.

• Copyright—Displayed InstallAnywhere’s copyright information. 

For Windows installer .exe files created using InstallAnywhere 2018, the project-specific values entered on the 
on the Project > General Settings page of the InstallAnywhere project file are now displayed on the Details tab 
of the Windows Properties dialog box, instead of the previously hard-coded values. 

Note • This change was tracked in issues IOJ-1559507 and IOJ-1556145.

Ability to Customize the Get Info Property Value for Copyright Field for 
an OS X / macOS Build Target

In previous releases, when you viewed the Copyright field on the Get Info dialog box for a Mac OS X build target 
for an installer targeting a OS X / macOS operating system, the copyright information specific to the version of 
InstallAnywhere used to create the installer was displayed instead of information specific to the product being 
installed:

In InstallAnywhere 2018, you can now customize the Get Info property value for the Copyright field for a Mac 
OS X build target.

The Copyright and Version fields can be edited on the InstallAnywhere Project > General Settings view under 
Product Information. The values entered here will be displayed on the dialog box that opens in OS X / macOS 
operating systems when you select the Get Info option.

Note • This change was tracked in issue IOJ-1827336.

Ability to Add Checkbox to Install Complete Panel to Launch Target 
Application or README File

In InstallAnywhere 2018, a new option has been added to configure the Install Complete panel to display a 
checkbox to prompt the user to launch a README file and/or launch a target application. The application could 
be either the main target application of the product that was just installed, or a utility installed alongside the 
product.

Note • This change was tracked in issues IOJ-1742892 and IOJ-1744734. 
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Option to Disable Logging Upon User Cancellation During Pre-Install 
Sequence

A new option has been added to enable you to disable logging if the user cancels an installation during the Pre-
Install sequence. 

To disable logging, open the Project > General Settings view of the Advanced Designer, scroll down to the Log 
Settings group, and set the Skip Logging in Pre-Install option to Yes. 

Note • This change was tracked in issue IOJ-1769638. 

Execute Script/Batch File Action Run in Console Mode Now Writes 
Action Type and Identifier to Console

When run in console mode, an InstallAnywhere installer displays a Please Wait message during installation for 
each Execute Script/Batch File action and Execute Command action included in the Install Sequence or 
Post-Install Sequence. 

In InstallAnywhere 2018, an installer running in console mode now identifies each action that displays a Please 
Wait message by also displaying the type of action (Execute Script/Batch File or Execute Command) and an 
action title/name.

Note • This change was tracked in issues IOJ-1805846 and IOJ-1811765.

In Console Mode, User Can Now Move Forward Without Scrolling 
Through the Entire License Agreement

In InstallAnywhere 2018, a new option has been added to enable users using a console mode installer to 
proceed to the next step without scrolling through the entire license agreement. 

When you add a License Agreement console screen to an installer on the Sequence > Pre-Install page, you can 
now select the Do not force user to scroll through license agreement option. 

Figure 11: Properties Tab of Console: License Agreement Console Screen
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When this option is selected, users using a console mode installer will be able to accept or reject the license 
agreement without scrolling through all of the text of the license agreement. The following text will be 
displayed: 

PRESS ANY KEY TO CONTINUE TO READ LICENSE AGREEMENT OR PRESS '0' to ADVANCE TO END

Note • To control whether a user using a panel mode installer can proceed to the next step without scrolling 
through the entire license agreement, use the Force user to scroll through license agreement option on the 
Properties tab of the Panel: License Agreement > Properties tab. 

Note • This change was tracked in issue IOJ-1559962.

Ability to Set Compiler Flags, Such as SafeSEH, for Executables 
Installed on Windows

In previous releases, executables installed on Windows did not meet security requirements because compiler 
flags, such as SafeSEH, were not set. In InstallAnywhere 2018, compiler flags are now set properly for 
executables installed on Windows. These executables now pass the SafeSEH check.

Support has been added to LaunchAnywhere (32-bit and 64-bit) and SelfExtractor (32-bit and 64-bit) projects 
for the following flags:

• /SAFESEH—This is applicable only for 32-bit target and not applicable for 64-bit targets. Therefore, for all 
64-bit build configurations, we have set this flag to NO.

• /HIGHENTROPYVA—This is applicable only for 64-bit executable images. This is not applicable for 32-bit 
executable images.

Note • This change was tracked in issue IOJ-1838458. 

ANT Version Associated with Execute ANT Script Action Updated to 
ANT 1.9.9

In InstallAnywhere 2018, the ANT version associated with the Execute ANT Script action has been updated to 
ANT 1.9.9 for both InstallAnywhere development and InstallAnywhere runtime. 

ANT 1.9.9 supports Java 1.5 and above. For more information, see:

http://ant.apache.org/manual/install.html

https://ant.apache.org/faq.html

Note • This change was tracked in issue IOJ-1663063. 
InstallAnywhere 2018 Release Notes  (Originally released March 2018; Updated to include SP1, released November, 2018) 20

http://ant.apache.org/manual/install.html
https://ant.apache.org/faq.html


New Compare Versions Rule
InstallAnywhere 2018 now includes a new Compare Versions rule that enables you to specifically compare two 
version numbers during an installation. This new rule is displayed on the Choose a Rule/Expression dialog box 
that opens when you click Add Rule on the Organization or Sequence page. 

Figure 12: New Compare Versions Rule

When you add a Compare Versions rule, you are prompted to enter two operands and an operator in the 
Compare Versions Properties Customizer. Both operands may be expressed as either an InstallAnywhere 
variable being resolved (such as $VARIABLE1$) or as a literal version number string (such as 1.0.0.0). 

Figure 13: Compare Versions Rule Properties Customizer

Note • This change was tracked in issue IOJ-1806918. 
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Expand/Collapse Buttons on Sequence Page Views
In InstallAnywhere 2018, an Expand and a Collapse button have been added to views on the Sequence page to 
quickly collapse or expand the items in the Action List tree. 

Figure 14: New Expand and Collapse Buttons on the Sequence Page

When you click the Collapse button, the items in the tree are collapsed into their primary item:

Figure 15: Collapsed Items in the Tree

Note • This change was tracked in issues IOJ-1560032 and IOJ-1559979.
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Get Password Action Console Panel Now Available in Pre-Uninstall 
and Post-Uninstall Phases

Previously, you could not add a Console: Get Password action during Pre-Uninstall and Post-Uninstall tasks 
for console mode installers. 

In InstallAnywhere 2018, you can now add a Console: Get Password action during Pre-Uninstall and Post-
Uninstall tasks for console mode installers. You can also add a Console: Get Password action during Pre-
Uninstall and Post-Uninstall tasks after adding a merge module project, which previously was not possible. 

Note • This change was tracked in issue IOJ-1562099.

New User-Defined Range of Installer Exit Codes
InstallAnywhere 2018 now includes a range of user-defined installer exit codes. These can be used to act upon 
scripts that are included in your installers. The following 20 exit codes were added for customer use:

Note • This change was tracked in issue IOJ-1563384.

New Variable to Store Response File Location
A new InstallAnywhere variable named $IA_RESPONSEFILE_PATH$ has been added to store the complete 
location of a response file being used by the installer. 

Note • This change was tracked in issue IOJ-1562772.

New Option to Specify Whether to Save Installer Project Before Build
In previous releases, when you initiated a build from the InstallAnywhere user interface, InstallAnywhere would 
first save the current project before performing the build.  

In InstallAnywhere 2018, a new option has been added to the General Settings tab of the InstallAnywhere 
Preferences dialog box named Save the project before build that determines whether a project is saved 
before the build is performed:

• Option is selected—The project is saved prior to building the installer; all settings are saved. 

Category Exit Codes

Linux Exit Codes 43 to 62

Other Exit Codes 10795 to 10814
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• Option is not selected—If you make changes to project settings and then build the installer, the setting 
changes are in the built installer but they are not saved to the project file. 

Note • This change was tracked in issue IOJ-1733987.

Important Information
Note the following important information regarding InstallAnywhere 2018:

• Project Wizard Interface Removed

• Runtime Support for Java 1.6 Dropped

• Solaris Support for InstallAnywhere Designer Dropped

• Evaluating InstallAnywhere

• Obtaining the Installation and License Files for InstallAnywhere

Project Wizard Interface Removed
In previous releases of InstallAnywhere, both a Project Wizard and Advanced Designer interface were available. 
Starting with InstallAnywhere 2018, the Project Wizard interface is no longer available. 

Runtime Support for Java 1.6 Dropped
InstallAnywhere 2018 no longer includes runtime support for Java 1.6.

Solaris Support for InstallAnywhere Designer Dropped
InstallAnywhere 2018 no longer supports the Solaris operating system for its designer user interface. However, 
InstallAnywhere will continue to provide Solaris runtime support.

Evaluating InstallAnywhere
Note that if you have not purchased a license for InstallAnywhere, you can install it and use it for a limited 
number of days without setting up the licensing. When you are using InstallAnywhere in this scenario, it 
operates in evaluation mode. The licensing wizard that InstallAnywhere displays whenever you launch 
InstallAnywhere in evaluation mode shows you how many days are left in the evaluation period. If you do not 
set up the licensing within the evaluation period, InstallAnywhere stops working when the evaluation period 
ends. You can set up licensing at any time before or after the evaluation period ends.

When you use InstallAnywhere in evaluation mode, there is a time limit for running installers that it creates. If 
you build an installer in the evaluation version of InstallAnywhere, your installer will stop working after 3 days.

When you use InstallAnywhere in evaluation mode, InstallAnywhere limits you to a maximum of five successful 
builds of Docker containers.
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Obtaining the Installation and License Files for 
InstallAnywhere

You can obtain the installation and license files for InstallAnywhere through the Flexera Product and License 
Center. For instructions, see the download and licensing instructions for InstallAnywhere. If you purchased 
concurrent licenses of InstallAnywhere, the license server software is also available for download from that 
same site.

Resolved Issues
This section lists the customer issues that were resolved in the following versions of InstallAnywhere 2018:

• InstallAnywhere 2018 SP1

• InstallAnywhere 2018

InstallAnywhere 2018 SP1
The following issues have been resolved in InstallAnywhere 2018 SP1.

Issue Number Issue Summary

IOJ-1889471 The Windows JVM Search Paths should be updated to include the new registry keys used 
by Java 9 and later.

IOJ-1885995 Running an upgrade installer, not the uninstaller, results in an Flexeraaw6$aaa: 
\iawin32.dll not found error and a Java stack trace after clicking the OK button on the 
Instance Management dialog to upgrade the instance.

IOJ-1883937 The Instance Management dialog displays text in English, except for the text on the OK 
and Cancel button. The dialog displays in English instead of the selected non-English 
locale / language.

IOJ-1881248 After being prompted for the next disk for a CD-ROM installer, there is an error message 
which displays - the volume is busy on Linux when unmounting the previous disk; Which 
prevents the continuation and completion of the install.

IOJ-1878623 On Linux, an installer built as a CD-ROM release prompts for a disk with a browse dialog. 
When clicked the browse button, the installer hangs with a blank dialog and a 
java.lang.Exception: Stack trace Java exception.

IOJ-1878403 Secure Text Input Prompt no longer required for Input Fields for authenticated macOS 
Installer which targets macOS 10.13 High Sierra.

IOJ-1875282 Cannot run program IAFileAttributes.exe build error when building a windows target on 
non-windows.
InstallAnywhere 2018 Release Notes  (Originally released March 2018; Updated to include SP1, released November, 2018) 25

https://flexerasoftware.flexnetoperations.com/
https://flexerasoftware.flexnetoperations.com/
http://www.flexerasoftware.com/instructions/product-license.htm


IOJ-1873616 Only on Windows running under the Japanese locale, the InstallAnywhere IDE displays 
garbled characters instead of double-byte Japanese characters.

IOJ-1872666 Installer Always uses English language Charset for language selection panel on macOS 
10.13

IOJ-1870592 Unable to go back to choose install Sets Panel with previous button if a feature rule was 
Toggled after the panel.

IOJ-1825583 64 bit Linux installer for InstallAnywhere should install the correct FNP libraries based on 
OS.

IOJ-1754300 64-bit copies of InstallAnywhere 2015 and InstallAnywhere 2015 SP1 fail to register with 
node-locked license file on 64-bit Linux.

IOJ-1748653 Java java.lang.InternalError error is generated when running installer in Console Mode 
from remote connection on Windows to Linux through SSH with X forwarding enabled 
without X Server running on Windows client.

IOJ-1730701 Build time variables not picked up in IDE.

IOJ-1722754 After a silent install, running the GUI install in maintenance mode freezes on the loading 
screen after selecting to modify an existing instance.

IOJ-1563142 When adding a custom rule to an action, prepending a ‘!’ to the Rule Expression causes a 
ClassNotFound exception.

IOJ-1562155 Build-time variables with names with any or all lowercase characters are not getting 
resolved when defined as environment variables

IOJ-1559570 The Message “Please Choose the Features to be installed by this Installer” of “Choose 
Product Features” needs to be modified.

IOJ-1557358 When using “Override default Unix permissions” with over 2048 files, it appears the 
permissions are not set for every 2048th file.

IOJ-1892333 User input fields fail to display default value after applying private patch A.

IOJ-1889884 When using Java 9, the Plug-In fails with java.lang.ClassFormatError on extracting a file 
using the Extract to File.

IOJ-1883950 Control IDs are not displayed for controls on custom code panel but only built-in panels.

IOJ-1850910 With slow network connectivity, the parent installer with merge module takes at least 
twice as long to complete the installation.

IOJ-1885337 During the build time, Java runtime environment fatal error occurs when building 
multiple projects through Ant.

Issue Number Issue Summary
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InstallAnywhere 2018
The following issues have been resolved in InstallAnywhere 2018.

IOJ-1835409 On upgrading the project, there is no current theme and theme location set in project 
XML. Hence, the Custom UI Designer fails to open.

Issue Number Issue Summary

IOJ-1554511 Request for OpenJDK support.

IOJ-1556346 When a Get User Input Console is added to a project, and a label is configured in the 
console that does not have a default value, when the console is displayed at runtime, that 
label displays the word DEFAULT in the default field for that label. The default field for 
that label should be empty.

IOJ-1559262 If you add a Choose Java VM Console panel to the Pre-Install phase, build the project 
with and without JVM, run the installer (either without VM or with VM), and select a VM 
from the list of installed JVMs on the system, it takes the JVM but displays the following 
error message: “Unable to install the Java Virtual Machine including with the installer”. 
This is a meaningless error message for end users. A more helpful message should be 
displayed. 

IOJ-1560820 Request to change the name of two component types on the Configure Choice Group 
dialog box: change Popup Menu to Dropdown List, and change List to List Box. 

IOJ-1561130 On an installer panel that uses right-to-left text orientation, when there is a long string, 
the scroll bar should start on the right side instead of the left.

IOJ-1561244 An Execute Uninstaller action will fail if the install path is a UNC path.

IOJ-1561449 When executing the following command through Execute Script/Batch File Action and 
Execute Command Action on Linux:

echo -n $variable

a newline character is added to the string stored in the $EXECUTE_STDOUT$ 
InstallAnywhere variable set by the Action, even though the -n parameter of the echo 
command should remove any newline characters in the command output on Linux.

IOJ-1562005 When using a Modify Text File action with the Substitute InstallAnywhere variables in 
file option selected, InstallAnywhere would correctly substitute the InstallAnywhere 
variable; however it would also remove references to UNIX variables in the file. 

IOJ-1562486 Enhance the search functionality in the interface so that it will actually navigate to and 
select the Actions/Panels returned by the search.

Issue Number Issue Summary
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IOJ-1749315 Including JAVA_HOME in any string value will cause double slashes or multiple consecutive 
slashes to resolve into a single slash. 

IOJ-1759801 When a project consists of two build configurations, and tags are utilized to include files 
that are specific to each build configuration, you should be able to build a build 
configuration even when the other build configuration references files that are currently 
missing on the build machine. However, when trying to build through ANT, with a 
buildproperties.properties file, or a buildproperties.xml file, this fails and displays 
an error message beginning with:

The following resources are missing from the project:

IOJ-1763540 Incorrect features are installed when installing silently and specifying only one feature to 
be installed with response file.

IOJ-1765167 If the installvariables.properties file is missing from the uninstall directory, 
launching the uninstaller should cause a fatal application error: This Application has 
Unexpectedly Quit...

However, if the installvariables.properties file is missing from the uninstall directory, 
and the Default Install Folder setting does not contain $PRODUCT_NAME$ or 
$INSTALLER_TITLE$, the Fatal Application Error message dialog fails to appear during 
uninstall.

IOJ-1766324 The uninstaller displays a Java NullPointerException Exception in Maintenance Mode. 
This occurs when Maintenance Mode support is enabled and custom Maintenance Mode 
icons are specified in the project.

IOJ-1771771 When the Remove unused keys from the locale files setting is enabled, the Choose 
Language Console Panel Title and Prompt with External Resource Bundle fails to get 
localized.

IOJ-1781156 Specifying an instance of a product with Instance Management fails on Java 9 with a 
java.lang.ClassCastException.

IOJ-1806933 When viewing on a Retina Display or a High Definition Display, images and panels inserted 
into an installer using InstallAnywhere 2017 are disproportionately bigger and more 
pixelated in contrast to those inserted using InstallAnywhere 2015 SP1. This issue was 
reported specifically on Mac macOS Sierra 10.12.

IOJ-1807464 On AIX, when the installation directory path matches the name of a filesystem on that 
machine, the Available Disk Space value on the Pre-Install Summary panel is for the 
matching filesystem, not the target filesystem.

IOJ-1812779 Setting the Inner Panel to a background color causes increased CPU usage with installers 
built using InstallAnywhere 2015/2015SP1/2017. The CPU uses goes up by almost 30% as 
compared to any other background color setting mode. 

Issue Number Issue Summary
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IOJ-1815731 The Software Manager is unable to download InstallAnywhere 2017 Public Hotfix A. When 
the download link is clicked, a blank Software Manager window is shown but nothing else 
happens.

IOJ-1818175 Using the Start Windows Service action after registering the LaunchAnywhere as a service 
on Windows 2008 fails to start the service. However, the standard installation logs state 
that the service started successfully. 

IOJ-1818724 Check Running Mode Rule shows the wrong options in Install and Uninstall Sequences 
depending on which sequence was previously selected.

IOJ-1818808 The Close button (X) on the Build information dialog does not work.

IOJ-1824220 Silent installer fails to launch and displays Installer User Interface Mode Not Supported 
error message with DISPLAY environment variable set. 

IOJ-1826255 Help article “Creating CD-ROM/DVD Installers” should no longer use Mac OS X as an 
example for platforms that cannot be bundled with a VM.

IOJ-1828026 When using a non-default theme, there is 100% CPU usage and a significantly slower 
install.

IOJ-1828582 When running a machine under French (Canada) locale, Instructions and Confirmation 
values are not localized on the Language Selection Panel. 

IOJ-1829617 When the Windows PATH environment variable contains a trailing semicolon at the end of 
the value, this causes the LaunchAnywhere launcher to fail to launch the target 
application from the command prompt.

IOJ-1830212 An installer built with a non-default theme does not display the shadowed masking dot 
character on a Get User Input Advanced Panel Shadowed text field.

IOJ-1830655 When the Splash screen OK button is localized via external resource bundle, it displays the 
$L string without resolving it to the value contained in the external resource bundle.

IOJ-1830666 There is a build warning / error every time a user builds without configuring digital 
signing.

IOJ-1830802 Keyboard keys no longer work on License Agreement panel. The panel does not respond 
to the keyboard keys, such as the Tab key and the Space bar key, like it did with 
InstallAnywhere 2015 SP1.

IOJ-1831386 When the Default File Overwrite Behavior in Project > General Settings File Settings is set 
to Always prompt user, the built installer does not have any buttons for Overwrite 
Existing File Dialog box on Linux and Mac OS X when the installation contains a file whose 
name and target location matches a file that is already present on a target system.

Issue Number Issue Summary
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IOJ-1834583 Request to add a note to the user documentation stating that when setting up instance 
management, you should not include a variable in the name of the uninstaller launcher. 
This breaks the instance management feature. 

IOJ-1834594 The command-line builder fails to build a project with a java.lang.NoClassDefFoundError 
error and java.lang.NullPointerException exception, when the DISPLAY environment 
variable is set to a value that references an inactive port. But since it is the command-line 
builder, not the Advanced Designer builder, the build should succeed regardless of the 
DISPLAY environment variable value.

IOJ-1834611 Create Link, Alias, Shortcut Action fails to resolve InstallAnywhere variables in name

IOJ-1834947 When specifying a root drive as the Existing file for the Copy File Action, this causes a slow 
launch of the installer, a slow display of the Pre-Install Summary Panel, and incorrect 
Required Disk Space to be displayed.

IOJ-1835596 The Get User Input Console Panel / Action does not accept a blank value, so the user 
cannot continue without making a selection.

IOJ-1835893 Expand Archive (Tar) action fails to extract the .tar when the target directory has a space 
in its name.

IOJ-1837797 When opening an existing project from within InstallAnywhere 2017, a browse dialog is 
displayed. Prior to InstallAnywhere 2017, this path would be set based on the path of the 
last opened project. In InstallAnywhere 2017, the default path no longer changes.

IOJ-1837914 $prop.line.separator$ fails to resolve on InstallAnywhere 2017 SP1. For example, a line 
such as:

LINE1$prop.line.separator$LINE2 

should print out on two separate lines.

IOJ-1838140 The installer displays help information that references swing instead of gui for use with 
the -i parameter.

IOJ-1838437 The Compare InstallAnywhere Variables rule fails to detect if a string contains a space.

IOJ-1838845 The Compare InstallAnywhere Variables rule is no longer evaluating correctly for values 
checked for a space character. 

IOJ-1844042 In the InstallAnywhere user documentation, Include what library is used for the Match 
Regular Expression rule.

IOJ-1844850 Question mark ? character in target installation directory path causes the installer to hang 
after the user tries to Cancel and Exit.

Issue Number Issue Summary
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System Requirements
The following are the system requirements for InstallAnywhere 2017:

• Requirements for Systems That Are Running InstallAnywhere (Authoring Environment)

IOJ-1847121 Regardless of the scaling percentage selected in the platform setting, the splash screen is 
never scaled. Instead, the splash screen is always the same size. With DPI Awareness on a 
high resolution display, the splash screen size should adjust and increase with a higher 
percentage for the scaling.

IOJ-1848178 On Windows, if a $PRODUCT_NAME$ InstallAnywhere variable contains a space, the Add or 
Remove Programs entry is left behind after uninstall. 

IOJ-1849701 Launching InstallAnywhere generates the following error message:

isus.UpdateServiceException: The server digitally signed its response with 

an untrusted certificate. Bad chain. Java error stack trace

IOJ-1849848 When Frameless Windows is enabled in UI, the close (X) button fails to trigger a rollback, 
even when rollback is enabled, and a partial install is leftover on the machine. Using the 
Cancel button instead works fine, and a rollback is properly triggered.

IOJ-1849850 Selecting the Disable Cancel Button When Install Is In Progress option fails to disable 
the close (X) button when Frameless Windows is enabled in UI.

IOJ-1850269 Request to update the user documentation to state that the Expand Archive action only 
supports .zip files that are zipped with the DEFLATE compression method.

IOJ-1850733 A java.lang.ArrayIndexOutOfBoundsException is generated when passing the -i 
parameter without the additional UI Mode parameter on command-line when launching 
the installer. Instead, an error message should be generated informing the user that the UI 
Mode parameter is required and must be enabled before building the installer.

IOJ-1851086 An error occurs at build-time when a non-default theme is selected and authentication is 
enabled for Mac:

I/O related error creating Mac OS X web installer.

IOJ-1855934 Avast Antivirus flags ZGUtil.class as an issue starting with installers built using 
InstallAnywhere 2017 SP1. Avast also flags files in the InstallAnywhere 2017 directory.

IOJ-1861337 After applying InstallAnywhere 2015 SP1 Public Hotfix A, the License Agreement panel 
appears blank when running the installation on Linux Machines. 

IOJ-1863215 The location provided for the Create JRE VM Pack Wizard is incorrect in the Using the 
Create JRE VM Pack Wizard Help Page. The Wizards > Create JRE VM Pack command is on 
the Tools menu, not the File menu.

Issue Number Issue Summary
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• Requirements for Docker Images

• Requirements for Target Systems (Installer Run-Time Environment)

• Supported Java Virtual Machines

• Requirements for Virtual Appliances

• Supported Hypervisors and Platforms for Virtual Appliances

Requirements for Systems That Are Running 
InstallAnywhere (Authoring Environment)

RAM

256 MB; 512 MB preferred

Hard Disk Free Space

500 MB

Color

High color (16-bit color depth)

Resolution

Minimum 1200 x 800
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Operating System

InstallAnywhere runs on the latest versions of these operating systems, fully updated with the most recent 
patches and service packs.

Operating System Supported Versions

Windows • Windows 10(1809)

• Windows Server 2019(x64)

• Windows 10 Fall Creators

• Windows 10 Anniversary Update (x86 and x64)

• Windows 2016 Server (x64)

• Windows 10 (x86 and x64)

• Windows 8.1 (x86 and x64)

• Windows Server 2012 R2 (x64)

• Windows 8 (x86 and x64)

• Windows Server 2012 (x64)

• Windows 7 (x86 and x64)

• Windows Server 2008 R2 (x64)

• Windows Vista

• Windows Server 2008 (x86 and x64)

Apple • macOS Mojave (10.14) with Oracle Java 8, 9, 10 or 11

• macOS High Sierra (10.13.3) with Java 7 or 8

• macOS Sierra (10.12) with Oracle Java 7 or 8

• OS X El Capitan (10.11) with Oracle Java 7 or 8

• OS X Yosemite (10.10) with Oracle Java 7 or 8

• OS X Mavericks (10.9.2) with Oracle Java 7 or 8

• OS X Mountain Lion (10.8) with Oracle Java 7 or 8

• OS X Lion (10.7.5) with Oracle Java 7
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Installers can be built from any supported authoring platform for any other supported target platform or 
language. Localizations for 32 languages are included.

Linux • Red Hat Enterprise Linux 7.3, 7.4 and 7.5 (x64)

• Red Hat Enterprise Linux 7.2 (x64) 

• Red Hat Enterprise Linux 7/7.1

• Red Hat Enterprise Linux 6.x (desktop and server editions; x86 and x64) 

• Red Hat Enterprise Linux 5.x (x86 and x64) 

• OpenSUSE Leap 42.3 (x64)

• OpenSUSE Linux 13.2 (x64) 

• OpenSUSE Linux 11.x, 12.x and 13.1 (x86 and x64) 

• SUSE Linux Enterprise 11 (SP2 and SP3; x64) and 12 (SP1, x64) 

• Linux PPC 64-bit (build time only) only with Java 6 

• Ubuntu 18.04 (x64)

• Ubuntu 17.10 (x64)

• Ubuntu 17.04 (x64)

• Ubuntu 15.04 (x64) 

• Ubuntu 14.x (x64) 

• Ubuntu 13.x (desktop and server editions; x86 and x64) 

• Ubuntu 10.x, 11.x, and 12.x (x86 and x64) 

• Fedora 18, 19, 20, 24 and 27, 28 (desktop editions; x64)

Note • When you install InstallAnywhere on a Linux system, the installation 
attempts to create a symbolic link to the default Linux loader (/lib/ld-linux.so.2) if a 
link with the same name is not already present. The symbolic link is necessary for 
the host ID to be displayed on the Host ID dialog, and it is also necessary for 
successful node-locked licensing. The link is present on systems that are Linux 
Standard Base (LSB) 3 compliant, but it may not be present on systems that are 
not LSB compliant. For more information, see Knowledge Base article Q209204.

Operating System Supported Versions
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Requirements for Docker Images
Support for building Docker images from InstallAnywhere 2017 when Docker is installed on the platforms 
below.

Requirements for Target Systems (Installer Run-Time Environment)

RAM

64 MB

Color

High color (16-bit color depth)

Resolution

Minimum 640 x 480

Item Description

Docker Version 
Supported

Docker 1.7.1

Platforms Windows • Windows 7

Linux • Ubuntu 14.10 

• Red Hat Enterprise Linux 7.1 

• CentOS 7.1 

Apple • OS X 10.8.x, 10.9.x, and 10.10.3
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Operating System

Installers run on any version of these operating systems, as long as the operating system supports Java 6, 7, or 
8 (but Oracle Java 7 or 8 for OS X). InstallAnywhere-generated installers are not supported on beta versions or 
on early-access releases unless they are explicitly mentioned.

Operating System Supported Versions

Windows • Windows 10 (1809)

• Windows Server 2019 (x64)

• Windows 10 Fall Creators

• Windows 10 Anniversary Update (x86 and x64)

• Windows 2016 Server (x64)

• Windows 10 (x86 and x64)

• Windows 8.1 (x86 and x64)

• Windows Server 2012 R2 (x64)

• Windows 8 (x86 and x64)

• Windows Server 2012 (x64)

• Windows 7 (x86 and x64)

• Windows Server 2008 R2 (x64)

• Windows Vista (x86 and x64)

• Windows Server 2008 (x86 and x64)

Windows-based target systems must also support the SSE2 instruction set.

Apple • macOS Mojave(10.14) with Oracle Java 8 or 9 or 10 or 11

• macOS High Sierra (10.13.3) with Oracle Java 7 or 8macOS Sierra (10.12) 
with Oracle Java 7 or 8

• OS X El Capitan (10.11) with Oracle Java 7 or 8

• OS X Yosemite (10.10) with Oracle Java 7 or 8

• OS X Mavericks (10.9.2) with Oracle Java 7 or 8

• OS X Mountain Lion (10.8) with Oracle Java 7 or 8

• OS X Lion (10.7.5) with Oracle Java 7
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Linux • CentOS 7.4 (x86, x64)

• CentOS 7.3 (x86, x64)

• CentOS 7 (x86, x64)

• CentOS 6.8 (x86, x64)

• Red Hat Enterprise Linux 7.5 (x64)

• Red Hat Enterprise Linux 7.4 (x64) 

• Red Hat Enterprise Linux 7.3 (x64) 

• Red Hat Enterprise Linux 7.2 (x64) 

• Red Hat Enterprise Linux 7.2 for PowerPC (little endian)

• Red Hat Enterprise Linux 7/7.1 

• Red Hat Linux 7.1 for PowerPC (little endian - silent and console mode only) 

• Red Hat Enterprise Linux 6.x, SUSE 11.x on zSeries 

• Red Hat Enterprise Linux 6.x SUSE 11.x PPC 64-bit (build time only) with 
Java 6 

• Red Hat Enterprise Linux 6.x (desktop and server editions; x86 and x64) 

• Red Hat Enterprise Linux 5 (x86, x64, Itanium 2, and AMD-64)

• OpenSUSE Linux 42.3 (x64)

• OpenSUSE Linux 13.2 (x64) 

• OpenSUSE Linux 11.x, 12.x and 13.1 (x86 and x64) 

• SUSE Linux Enterprise 11 (SP2 and SP3; x64) and 12 (SP1, x64) 

• Ubuntu 18.04 (x64)

• Ubuntu 17.10 (x64)

• Ubuntu 16.04 LTS (x64)

• Ubuntu 15.04 (x64) 

• Ubuntu 14.x (x64) 

• Ubuntu 13.x (desktop and server editions; x86 and x64) 

• Ubuntu 9.x, 10.x, 11.x, 12.x (x86 and x64) 

• Fedora 18, 19, 20, and 24, 26, 27, 28 (desktop editions; x64)

Solaris • Solaris 11 (x86 and SPARC)

• Solaris 9, 10 (x86, SPARC, and AMD-64)

HP-UX • HP-UX 11i (Itanium 2 and PA-RISC)

AIX • AIX 5.2, 5.3, 6.1, and 7.1 (Power/PowerPC)

Operating System Supported Versions
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Supported Java Virtual Machines
InstallAnywhere supports the following Java virtual machines:

The InstallAnywhere installer installs JRE 1.7.0_60 VM packs. Any Java virtual machine can be bundled with an 
installer ensuring that the target system meets the minimum requirements for both the installers and your 
applications. To download additional JRE VM packs, visit http://www.flexerasoftware.com/installanywhere/
utilities and click the VM Packs tab.

InstallAnywhere-generated installers are not supported on beta versions or on early-access releases of Java.

Requirements for Virtual Appliances
The following are requirements for virtual appliances:

• System Requirements for Building and Auto-Deploying Virtual Appliances

• Supported Hypervisors and Platforms for Virtual Appliances

IBM • i5/OS (OS/400) on System i - V5R3 and V5R4 (Enterprise Edition only), IBM i 
6.1, and IBM i 7.1

• z/OS

Other • FreeBSD

• Other Linux and UNIX operating systems (POSIX-compliant shell required)

Manufacturer Supported Versions

Sun 1.7.x, 1.8.x, 9

IBM 1.7.x, 1.8.x, 9

HP 1.7.x, 1.8.x, 9

Oracle 1.7.x, 1.8.x, 9, 10, 11

OpenJDK 1.7.x, 1.8.x, 9, 11

Operating System Supported Versions
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System Requirements for Building and Auto-Deploying Virtual 
Appliances

The following table lists the system requirements for building and auto-deploying virtual appliances from 

within InstallAnywhere.

Supported Hypervisors and Platforms for Virtual Appliances
InstallAnywhere supports the creation of virtual appliances that run on VMware vSphere 5 and Amazon EC2 
hypervisors. A VMware vSphere 5 virtual appliance is deployable on a licensed VMware vSphere 5 Server 
(standalone) or a licensed VMware vSphere 5 Server that is managed by a licensed VMware vCenter 5 Server.

The following table identifies the operating systems that are supported on the supported hypervisors.

Hypervisor Requirements

VMware vSphere 5/
vCenter

• Credentials to a VMware vSphere 5 Server 

• If your VMware vSphere 5 Server is managed by a VMware vCenter 5 Server, 
the credentials to the VMware vCenter Server are also required. 

• Host machine credentials (credentials to a physical/virtual machine that 
closely resembles the virtual appliance operating system)

Amazon EC2 • Amazon EC2 account information (account number, access key, secret key, 
X.509 certificate, and private key associated with your Amazon EC2 account) 

• Host machine credentials (credentials to a physical/virtual machine that 
closely resembles the virtual appliance operating system) 

Supported Hypervisor Supported Operating Systems

VMware vSphere 5/vCenter • CentOS 7, 6.2 and 6.3 (x86 and x64)

• OpenSUSE 12.2 (x86 and x64) and SUSE Linux Enterprise Server 11 
SP2—Requires the use of an existing SUSE VM or snapshot (No 
support for using a SUSE VM virtual appliance template) 

• Red Hat Enterprise Linux 6.4 (x86 and x64)—Requires the use of a 
Red Hat Network–registered RHEL VM virtual appliance template 

• Red Hat Enterprise Linux 6.3 (x64)—Requires the use of a Red Hat 
Network–registered RHEL VM virtual appliance template 

• Ubuntu 13.04 (x86 and x64) 

• Ubuntu 12.10 (x86 and x64) 

• Ubuntu 12.04 (x86 and x64) 

• Ubuntu 11.10 (x86 and x64) 
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Known Issues
For a list of known issues, see the InstallAnywhere 2018 Known Issues knowledge base article.

Legal Information
Copyright Notice

Copyright © 2018 Flexera

This publication contains proprietary and confidential information and creative works owned by Flexera and its 
licensors, if any. Any use, copying, publication, distribution, display, modification, or transmission of such 
publication in whole or in part in any form or by any means without the prior express written permission of 
Flexera is strictly prohibited. Except where expressly provided by Flexera in writing, possession of this 
publication shall not be construed to confer any license or rights under any Flexera intellectual property rights, 
whether by estoppel, implication, or otherwise.

All copies of the technology and related information, if allowed by Flexera, must display this notice of copyright 
and ownership in full.

Intellectual Property

For a list of trademarks and patents that are owned by Flexera, see https://www.flexera.com/producer/
company/about/intellectual-property/. All other brand and product names mentioned in Flexera products, 
product documentation, and marketing materials are the trademarks and registered trademarks of their 
respective owners.

Restricted Rights Legend

The Software is commercial computer software. If the user or licensee of the Software is an agency, 
department, or other entity of the United States Government, the use, duplication, reproduction, release, 
modification, disclosure, or transfer of the Software, or any related documentation of any kind, including 
technical data and manuals, is restricted by a license agreement or by the terms of this Agreement in 
accordance with Federal Acquisition Regulation 12.212 for civilian purposes and Defense Federal Acquisition 
Regulation Supplement 227.7202 for military purposes. The Software was developed fully at private expense. 
All other use is prohibited.

Amazon EC2 • Ubuntu 11.10 (x32) 

• Ubuntu 12.04 (x32) 

Supported Hypervisor Supported Operating Systems
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